
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



1. โปรแกรมนีค้ืออะไร มีระดับใดบ้าง? 
โปรแกรมงานวิชาการชั้นเรียน-วิชาการโรงเรียน เป็นโปรแกรม Excel สำเร็จรูป ที่ใช้อำนวยความสะดวก
ในการจัดเก็บข้อมูลและออกเอกสารวิชาการชั้นเรียน และวิชาการโรงเรียน มีทั้งหมด 3 ระดับคือ 
1.1. โปรแกรมประเมินพัฒนาการเด็กปฐมวัย หลักสูตร 2560 
1.2. โปรแกรม ปพ.1-7 แบบมาตรฐาน ระดับประถมศึกษา 
1.3. โปรแกรม ปพ.1-7 แบบมาตรฐาน ระดับมัธยมศึกษา 

 

2. ความสามารถของโปรแกรม ทำอะไรได้บ้าง? 

2.1. ความสามารถของโปรแกรมปฐมวัย โดยสรุปมีดังนี ้
2.1.1. การบันทึกผลการประเมินพัฒนาการเด็กปฐมวัย 

2.1.1.1. สามารถนำเข้าข้อมูลนักเรียนจากระบบ DMC ของ สพฐ. ได้ 
2.1.1.2. สรุปเวลาเรียนอัตโนมัติ 
2.1.1.3. การบันทึกน้ำหนัก-ส่วนสูง และการประเมินภาวะโภชนาการ 
2.1.1.4. สรุปปัญหาภาวะโภชนาการ เป็นรายภาคเรียนและรายปี 
2.1.1.5. รายงานอัตราความชุกปัญหาโภชนาการ 
2.1.1.6. การประเมินมาตรฐานพัฒนาการ ตัวบ่งชี้ และสภาพที่พึงประสงค์ 12 มาตรฐาน 29 

ตัวบ่งชี้ 59 สภาพที่พึงประสงค์ ดังนี้ 
2.1.1.6.1. พัฒนาการด้านร่างกาย มาตรฐานที่ 1-2 มี 5 ตัวบ่งชี้ 13 สภาพที่พึงประสงค์ 
2.1.1.6.2. พัฒนาการด้านอารมณ์ จิตใจ มาตรฐานที่ 3-5 มี 7 ตัวบ่งชี้ 11 สภาพที่พึง

ประสงค์ 
2.1.1.6.3. พัฒนาการด้านสังคม มาตรฐานที่ 6-8 มี 8 ตัวบ่งชี้ 17 สภาพที่พึงประสงค์ 
2.1.1.6.4. พัฒนาการด้านสติปัญญา มาตรฐานที่ 9-12 มี 7 ตัวบ่งชี้ 18 สภาพที่พึงประสงค์ 

2.1.1.7. การรายงานนักเรียนที่ควรเสริมพัฒนาการ 
2.1.1.8. สามารถปรินท์รายงานได้ทั้งแบบรายเทอมและรายปี 

2.1.2.สามารถสรุปเป็นแบบรายงานประจำตัวเด็กปฐมวัย ได้โดยอัตโนมัติ เพื่อรายงานให้ผู้บริหาร
สถานศึกษาและผู้ปกครองทราบผลการประเมินพัฒนาการ 

2.1.2.1. หน้าปกสรุปรายละเอียดนักเรียนรายบุคคล 
2.1.2.2. คำแนะนำสำหรับผู้ปกครอง 
2.1.2.3. สรุปข้อมูลนักเรียน 
2.1.2.4. ผลการประเมินภาวะโภชนาการ 
2.1.2.5. สรุปเวลาเรียน 
2.1.2.6. มาตรฐานพัฒนาการ 4 ด้าน รายภาคเรียน-รายปี 
2.1.2.7. สรุปผลการประเมินพัฒนาการ 
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2.1.2.8. ความคิดเห็นของครูประจำชั้น 
2.1.2.9. ความคิดเห็นของผู้ปกครอง 

2.1.3. การออกใบรับรองผลการศึกษา 
2.1.4. โปรแกรมประเมินพัฒนาการเด็กปฐมวัย รองรับนักเรียนไฟล์ละ 45 คน/ห้อง 
2.1.5. สามารถคัดลอกไฟล์โปรแกรมได้ไม่จำกัดจำนวนไฟล์ ไม่จำกัดจำนวนเครื่องคอมพิวเตอร์ 
2.1.6. มีระบบช่วยเหลือระยะไกลผ่านโปรแกรม TeamViewer 
 

2.2. ความสามารถของโปรแกรมงานวิชาการโรงเรียน ระดับประถมศึกษา-มัธยมศึกษา โดยสรุปมีดังนี้ 
2.2.1. สามารถออกเอกสาร ปพ.1-7 ตามหลักสูตรแกนกลางการศึกษาขั้นพ้ืนฐาน พุทธศักราช 2551 
2.2.2. โปรแกรม ปพ.5-6 ประเมินผลสัมฤทธิ์ทางการเรียน ได้ 20 รายวิชาต่อเทอม/ปี 
2.2.3. สามารถเพ่ิมหรือลดจำนวนช่องกรอกคะแนนได ้(แบบบริหารพื้นทีห่น้ากระดาษเต็มหน้า) 
2.2.4. โปรแกรม ปพ.5-6 ประถมศึกษา สามารถกรอกคะแนนได้วิชาละ 50 ตัวชี้วัด/เทอม/ปี (และ

สามารถเพ่ิมหรือลดช่องกรอกคะแนนได้อัตโนมัติ) 
2.2.5. โปรแกรม ปพ.5-6 มัธยมศึกษา สามารถกรอกคะแนนได้วิชาละ 45 ตัวชี้วัด/เทอม  

(และสามารถเพ่ิมหรือลดช่องกรอกคะแนนได้อัตโนมัติ) 
2.2.6. สามารถเลือกประเมินมาตรฐาน/ตัวชี้วัดหรือไม่ก็ได้ (ประเมิน 2 ชั้น แบบ ผ่าน/ไม่ผ่าน)  
2.2.7. สรุปเวลาเรียนอัตโนมัติ  
2.2.8. การประเมินคุณลักษณะอันพึงประสงค์  
2.2.9. การประเมินการอ่าน คิดวิเคราะห์ และเขียนสื่อความ  
2.2.10. มีให้ทั้งแบบประเมินค่านิยมหลัก 12  ประการและไม่ประเมิน 
2.2.11. การประเมินสมรรถนะสำคัญของผู้เรียน  
2.2.12. การประเมินกิจกรรมพัฒนาผู้เรียน  
2.2.13. สามารถแสดงชื่อชุมนุมของนักเรียนแต่ละคนแตกต่างกันได้ 
2.2.14. สรุปรายงานผลการพัฒนาคุณภาพผู้เรียนรายบุคคล (ปพ.6) เชื่อมโยงอัตโนมัติ 
2.2.15. สรุปผลสัมฤทธิ์ทางการเรียนรายชั้นเรียนอัตโนมัติ 
2.2.16. โปรแกรม ปพ.1-2-3-7 รองรับนักเรียนไฟล์ละ 120 คน กรณีมีนักเรียนที่สำเร็จการศึกษาใน

แต่ละปีการศึกษามากกว่า 120 คนสามารถคัดลอกไฟล์ต่อ ๆ ไปได้ 
2.2.17. ปพ.2 ระดับมัธยม ปรับตามแบบพิมพ์ใหม่ล่าสุดปี 2563 (ผอ. ลงนามคนเดียว) 
2.2.18. ปพ.3 ระดับมัธยม สามารถส่งออกข้อมูลไปยังระบบ ปพ.3 ออนไลน์ของ สพฐ. ได้ 
2.2.19. โปรแกรม ปพ. 5-6 รองรับนักเรียนไฟล์ละ 45 คน/ห้อง 
2.2.20. สามารถคัดลอกไฟล์โปรแกรมได้ไม่จำกัดจำนวนไฟล์ ไม่จำกัดจำนวนเครื่องคอมพิวเตอร์ 
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3. ขั้นตอนก่อนการใช้งานมีอะไรบ้าง? 
3.1. ดาวน์โหลดไฟล์แนบ (.zip) ที่ส่งให้ทางกล่องข้อความเฟซบุ๊ก www.facebook.com/thaischool 
3.2. ดับเบ้ิลคลิกเปิดไฟล์ .exe เพ่ือติดตั้งโปรแกรมไปยังตำแหน่ง C:\โปรแกรมงานวิชาการโรงเรียน 

(สามารถเลือกตำแหน่งอื่นได้) 
3.3. ติดตั้งฟ้อนต์ที่ใช้แสดงผลในโปรแกรม โดยคัดลอกไฟล์ฟ้อนท์ไปยังตำแหน่ง C:\Windows\Fonts 
3.4. เลือกเปิดไฟล์ Excel (.xlsb) ที่ต้องการใช้งาน 
3.5. เปิดใช้งานแมโครทั้งหมดใน Excel โดยไปท่ีเมนู แฟ้ม>ตัวเลือก>ศูนย์ความเชื่อถือ>การตั้งค่าศูนย์

ความเชื่อถือ>การตั้งค่าแมโคร>เปิดใช้งานแมโครทั้งหมด>ตกลง>ตกลง 
(เมนูภาษาอังกฤษ: File>Excel Options>Trust Center>Trust Center Settings>Macro 
Settings>Enable all macros>OK>OK 

3.6. กรอกไฟล์ละ 1 ห้องเรียน ห้องละไม่เกิน 45 คน ถ้ามีหลายห้องเรียนให้คัดลอกไฟล์ตามจำนวน
ห้องเรียน กรอกเฉพาะช่องที่เป็นสีขาว ช่องสีชมพูหรือสีอ่ืน ๆ เป็นสูตร จะคำนวณให้อัตโนมัติ ไม่
ต้องกรอก 
 

  

http://www.facebook.com/thaischool
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4. การใช้งานโปรแกรมระดับปฐมวัย มีลักษณะและวิธีการใช้งานอย่างไรบ้าง? 
4.1. หน้าหลัก/สารบัญ เป็นหน้ารวมเมนูแผ่นงานทั้งหมดในโปรแกรม ซึ่งสามารถ คลิกที่เมนูนั้น ๆ เพื่อให้

เชื่อมโยงไปยังแผ่นงานต่าง ๆ ได้อย่างรวดเร็ว 
4.1.1. องค์ประกอบและการแบ่งหมวดหมู่ 
4.1.2. สามารถคลิกเมนู เพื่อเชื่อมโยงไปยังแผ่นงานต่าง ๆ และคลิกปุ่ม Home สีเขียวเพ่ือกลับหน้า

หลัก 

 
4.2. คู่มือ 

4.2.1. ควรศึกษาคู่มือให้เข้าใจ เพ่ือให้ทราบวิธีการใช้งาน การแก้ปัญหา และข้อควรระวังในการกรอก
ข้อมูล 

4.3. ข้อมูลพ้ืนฐาน ได้กำหนดชื่อสถานศึกษาในโปรแกรมเรียบร้อยแล้ว ให้ดำเนินการกรอกข้อมูลพื้นฐาน
อ่ืน ๆ ที่จำเป็นให้ถูกต้อง 

4.3.1. สังกัด ให้กรอกสำนักงานเขตพ้ืนที่การศึกษา หรือองค์การปกครองส่วนท้องถิ่นที่สังกัด 
4.3.2. ตำบล/อำเภอ/จังหวัด ให้กรอกโดยมีคำว่า ตำบล/อำเภอ/จังหวัดด้วย ในกรณีที่เป็น แขวง/เขต 

ให้กรอกคำว่า แขวง/เขต ด้วย 
4.3.3. ระดับชั้น ให้กรอก อนุบาล หรือ เตรียมอนุบาล 
4.3.4. ปีที่ ให้กรอกตัวเลขชั้นปีที่เรียน เช่น 1 2 หรือ 3 เป็นต้น 
4.3.5. อายุ ให้กรอกตัวเลขอายุชั้นปีของนักเรียน เช่น 3 4 หรือ 5 เป็นต้น 
4.3.6. ห้อง กรอกตัวเลขห้องเรียนที่จัดทำข้อมูล 
4.3.7. ปีการศึกษา กรอกตัวเลขปีการศึกษาที่จัดทำข้อมูล 
4.3.8. กรอกชื่อ-สกุล ครูประจำชั้น/ครูที่ปรึกษา 
4.3.9. กรอกชื่อ-สกุล และตำแหน่ง หัวหน้างานวิชาการ หรือนายทะเบียน ในกรณีออกใบรับรอง 
4.3.10. กรอกชื่อ-สกุล และตำแหน่ง ผู้บริหารสถานศึกษา 
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4.4. ข้อมูลนักเรียน การนำเข้าข้อมูลจากระบบ DMC ชื่อไฟล์ studentInSchoolList.csv  สามารถ
คัดลอกข้อมูลนักเรียนจากระบบ DMC มาวางลงในแผ่นงานข้อมูลนักเรียนได้ ซึ่งมีวิธีการดังนี้ 

4.4.1.การดาวน์โหลดไฟล์ข้อมูลนักเรียนจากระบบ DMC (ดูภาพประกอบ) 
4.4.1.1. เข้าระบบ DMC ที่ https://portal.bopp-obec.info/obec65/ 
4.4.1.2. กรอกชื่อผู้ใช้งานและรหัสผ่าน คลิกเข้าสู่ระบบ 
4.4.1.3. คลิกเมนู โรงเรียน>2.9 รายงานระดับโรงเรียน 
4.4.1.4. ที่บรรทัด ทะเบียนนักเรียนรายบุคคล คลิกดาวน์โหลดไฟล์ 

studentInSchoolList.csv หากเป็นข้อมูลภาคเรียนที่ 2 ไฟล์จะอยู่ด้านล่างลงไปอีก ให้
เลื่อนหน้าเว็บไซต์ลงไปด้านล่างสุดเพื่อดาวน์โหลด 

 
4.4.1.5. เปิดไฟล์ที่ดาวน์โหลดมาและคัดลอกข้อมูลนักเรียนเฉพาะห้องที่ต้องการทำข้อมูล 
4.4.1.6. คลิกท่ีตัวเลขหัวแถว เพ่ือลากคลุมข้อมูลนักเรียนทั้งแถว 
4.4.1.7. กดปุ่ม Ctrl+C หรือคลิกขวาเลือก คัดลอก (Copy) 
4.4.1.8. คลิกเปิดโปรแกรมงานวิชาการ ทีแ่ผ่นงาน “ข้อมูลนักเรียน”  
4.4.1.9. คลิกขวาที่เซลล์ A3 เลือกเมนูตัวเลือกการวาง “ค่า (า)” 
4.4.1.10. จากนั้น กดปุ่มสีเขียวที่อยู่ด้านขวามือ (ดูภาพประกอบ) หรือกดปุ่ม Ctrl+D เพ่ือ

ปรับปรุงข้อมูล  
4.4.2. การกรอกข้อมูลด้วยตนเอง ในกรณีท่ีไม่มีไฟล์ DMC หรือสังกัดอ่ืนนอกจาก สพฐ. สามารถ

กรอกข้อมูลใหม่ด้วยตนเอง (กรุณาอ่านคำแนะนำที่มุมสีแดง) วิธีการกรอกท่ีสำคัญมีดังนี้ 

https://portal.bopp-obec.info/obec65/
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4.4.2.1. รหัสโรงเรียน จำเป็นต้องกรอก ถ้าไม่กรอกข้อมูลอ่ืน ๆ จะไม่แสดง ถ้าไม่ทราบหรือ

เป็นสถานศึกษาท่ีไม่ได้สังกัด สพฐ. ให้กรอกตัวเลขอะไรก็ได้ 
4.4.2.2. เลขประจำตัวประชาชน ให้กรอกตัวเลขเรียงปกติ ไม่ต้องมีวรรค หรือขีด โปรแกรม

จะประมวลผลให้เองเมื่อกดปุ่มสีเขียว 
4.4.2.3. เพศชายให้กรอก ช เพศหญิงให้กรอก ญ (ตามระบบของ DMC) ถ้ากรอกเป็นอย่าง

อ่ืนนอกจาก ช หรือ ญ โปรแกรมจะประมวลผลเป็นเพศหญิง 
4.4.2.4. วันเกิด ให้กรอกในรูปแบบ วันที่/เดือน/พ.ศ. เช่น 23/01/2554 โปรแกรมจะ

คำนวณอายุให้โดยยึดจากตัวเลขวันเกิดนี้ 
4.5. ข้อมูลเพ่ิมเติม ให้กรอกข้อมูลเพิ่มเติมที่จำเป็น เช่น อาชีพบิดา มารดา และผู้ปกครอง ตรวจสอบและ

แก้ไขท่ีอยู่ปัจจุบันของนักเรียนให้ถูกต้อง ความคิดเห็นของครูประจำชั้นด้านต่าง ๆ และในกรณีออก
ใบรับรอง ให้กรอกเลขที่ใบรับรอง คำรับรองนักเรียน วันเดือนปีที่ออกให้ และหมายเหตุ 

4.6. ปกแบบบันทึก ให้ตรวจ แก้ไข และกรอกจำนวนนักเรียน ชาย-หญิง ต้นปีการศึกษา ออก-เข้าระหว่าง
ปีการศึกษา และจำนวนรวมให้ถูกต้อง 

4.7. ชื่อนักเรียน บิดามารดา ผู้ปกครอง จะเป็นข้อมูลที่โปรแกรมประมวลมาจากแผ่นงานข้อมูลนักเรียน
และข้อมูลเพิ่มเติมโดยอัตโนมัติ 

4.8. เวลาเรียนให้กรอกเป็นตัวเลขจำนวนวัน (เลขอารบิก) 
4.8.1. มาเรียน   ให้กรอกเลข 1 
4.8.2. ป่วย       ให้กรอก ป 
4.8.3. ลา          ให้กรอก ล 
4.8.4. ขาด        ให้กรอก ข 
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4.8.5. วันหยุดเสาร์-อาทิตย์ และวันหยุดพิเศษ สามารถเว้นว่างไว้ได้ แต่ถ้าต้องการเพ่ิมหมายเหตุ  
ว่าวันใดเป็นวันหยุดพิเศษ สามารถพิมพ์ในพ้ืนที่ตารางด้านล่างใตช้ื่อนักเรียนคนสุดท้ายได้ 

4.8.6. โปรแกรมจะสรุปเวลาเรียนให้โดยอัตโนมัติในแผ่นงาน “สรุปเวลาเรียน” 
4.9. การกรอกน้ำหนัก-ส่วนสูง ให้กรอกข้อมูล วันที่ชั่งน้ำหนัก/วัดส่วนสูง ในรูปแบบ 23/01/2554 เพ่ือให้

โปรแกรมคำนวณอายุของนักเรียนออกมาเป็น ปี-เดือน และกรอกน้ำหนักเป็นกิโลกรัม และส่วนสูง
เป็นเซนติเมตร 
โปรแกรมจะคำนวณอายุนักเรียน และประมวลผลตามเกณฑ์มาตรฐานของกรมอนามัย กระทรวง
สาธารณสุขให้โดยอัตโนมัติ ดังนี้ 

4.9.1.น้ำหนักตามเกณฑ์อายุ 
4.9.2.ส่วนสูงตามเกณฑ์อายุ 
4.9.3.น้ำหนักตามเกณฑ์ส่วนสูง 
4.9.4.นอกจากนี้ โปรแกรมจะสรุปอัตราความชุกของปัญหาโภชนาการ และสรุปรายชื่อนักเรียนที่มี

ปัญหาโภชนาการให้โดยอัตโนมัติ 
4.10. โปรแกรมจะประมวลผลการประเมินทั้งหมดมารายงานเป็นข้อมูลนักเรียนรายบุคคลให้โดย

อัตโนมัติ  
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4.11. มาตรฐานพัฒนาการ ตัวบ่งชี้ และสภาพที่พึงประสงค์ 12 มาตรฐาน 29 ตัวบ่งชี้ 59 สภาพที่
พึงประสงค์ ทั้ง 4 ด้านคือ ด้านร่างกาย ด้านอารมณ์และจิตใจ ด้านสังคม และด้านสติปัญญา  
ไม่จำเป็นต้องแก้ไข สามารถยึดตามมาตรฐานของหลักสูตรการศึกษาปฐมวัย 2560 ที่กำหนดไว้แล้ว
ได้เลย  

 
4.11.1.  หากกำหนดในข้อมูลพื้นฐานเป็นชั้นปีที่ 1 โปรแกรมจะดึงข้อมูลตัวบ่งชี้จากคอลัมน์  

A และ B ไปแสดงในตารางประเมินพัฒนาการ 
4.11.2.  หากกำหนดในข้อมูลพื้นฐานเป็นชั้นปีที่ 2 โปรแกรมจะดึงข้อมูลตัวบ่งชี้จากคอลัมน์  

A และ C ไปแสดงในตารางประเมินพัฒนาการ 
4.11.3.  หากกำหนดในข้อมูลพื้นฐานเป็นชั้นปีที่ 3 โปรแกรมจะดึงข้อมูลตัวบ่งชี้จากคอลัมน์  

A และ D ไปแสดงในตารางประเมินพัฒนาการ 
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4.12. การประเมินพัฒนาการ ทั้ง 4 ด้าน กำหนดผลเป็น 3 ระดับ ดังนี้ 
4.12.1.  ระดับคะแนน 1   =    ควรเสริม     

หมายถึง  ยังไม่พบพฤติกรรมที่แสดงพัฒนาการ หรือยังไม่ชัดเจน ควรได้รับการเสริมสร้าง
พัฒนาการให้ได้มาตรฐาน 

4.12.2.  ระดับคะแนน 2   =    พอใช้ 
หมายถึง  พบพฤติกรรมที่แสดงพัฒนาการเป็นบางครั้ง แต่ยังไม่คล่องและไม่สม่ำเสมอ หรือ
พัฒนาได้ใกล้เคียงมาตรฐาน 

4.12.3.  ระดับคะแนน 3     =    ด ี
หมายถึง  พบพฤติกรรมที่แสดงพัฒนาการได้บ่อย ปฏิบัติได้คล่องแคล่ว รวดเร็ว หรือพัฒนาได้
ตามเกณฑ์มาตรฐาน 

โปรแกรมจะคำนวณและสรุปพัฒนาการและรายงานเด็กท่ีควรได้รับการเสริมพัฒนาการ ทั้งแบบราย
ภาคเรียน และแบบรายปีการศึกษาให้โดยอัตโนมัติ 

4.13. โปรแกรมจะสรุปผลการประเมินพัฒนาการนักเรียนให้ทั้งแบบรายเทอมและรายปีว่านักเรียน
แต่ละคนมีผลการประเมินในระดับใด  

4.14. โปรแกรมจะสรุปและจำแนกผลการประเมินเป็นรายตัวบ่งชี้ว่าในการประเมินแต่ละครั้ง แต่
ละตัวบ่งชี้มีนักเรียนได้รับผลการประเมินแต่ละระดับจำนวนเท่าใด 

4.15. โปรแกรมจะสรุปรายชื่อนักเรียนที่ควรได้รับการเสริมพัฒนาการแต่ละด้านให้โดยอัตโนมัติ ทั้ง
แบบรายเทอมและรายปี 

4.16. ในส่วนของความคิดเห็นและข้อเสนอแนะของครูประจำชั้น สามารถกรอกได้ที่แผ่นงาน 
“ข้อมูลเพ่ิมเติม” เริ่มจากคอลัมน์ “BD” เป็นต้นไป 

4.17. การสั่งปรินท์ ผลการประเมินพัฒนาการนักเรียนรายบุคคล สามารถกรอกเลขที่ หรือคลิกปุ่ม
สามเหลี่ยมชี้ลงค้นหาจากรายชื่อของเรียนที่ต้องการสั่งปรินท์ได้ 

4.18. สามารถสั่งปรินท์ที่ละคน โดยกรอกเลขที่ แล้วกดปุ่ม Enter เพ่ือให้แสดงข้อมูลของนักเรียน 
หรือคลิกปุ่มสามเหลี่ยมชี้ลง แล้วค้นหาจากรายชื่อของนักเรียนที่ต้องการสั่งปรินท์ คลิก “พิมพ์ข้อมูล
ที่แสดง” หรือปรินท์ครั้งเดียวทั้งห้องเรียนได้ เพื่อความสะดวกในการทำรูปเล่มรายงาน โดยกรอก 
“เริ่มพิมพ์จากเลขท่ี” “ถึงเลขที่” แล้วคลิก “พิมพ์เป็นช่วง”เช่น เลขที่ 1-45 เป็นต้น 
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4.18.1. สามารถสั่งปรินท์ใบรับรองผลการศึกษา สำหรับนักเรียนที่จบการศึกษาหรือย้ายสถานศึกษา
ได ้โดยกรอกข้อมูลที่แผ่นงาน “ข้อมูลเพ่ิมเติม” เริ่มจากคอลัมน์ “BN” เป็นต้นไป 
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5. การใช้งานโปรแกรม ปพ.5-6 ระดับประถมศึกษาและมัธยมศึกษา มลีักษณะและ
วิธีการใช้งานอย่างไรบ้าง? 
5.1. โปรแกรม ปพ.5-6 ระดับประถมศึกษา แบ่งเป็น 2 แบบ 4 ไฟล์ สำหรับให้โรงเรียนเลือกใช้งานตาม

บริบท คือ  
5.1.1. แบบรายเทอม จะแบ่งการประเมินออกเป็น 2 ภาคเรียน มีการเก็บคะแนนระหว่างเรียน และ

การสอบปลายภาค ทั้งภาคเรียนที่ 1 และภาคเรียนที่ 2 แล้วนำผลการเรียนทั้ง 2 ภาคเรียนมา
หาค่าเฉลี่ยเป็นผลการเรียนตลอดปีการศึกษา มี 2 ไฟล์คือ แบบมีการประเมินค่านิยม 12 
ประการ และแบบไม่มีการประเมินค่านิยม 12 ประการ 
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5.1.2. แบบรายปี มีการเก็บคะแนนระหว่างเรียนตลอดปี แต่จะมีการสอบปลายปีครั้งเดียว แล้วคิด
เป็นผลการเรียนตลอดปีการศึกษา โดยไม่แยกเป็นภาคเรียนที่ 1 หรือภาคเรียนที่ 2 มี 2 ไฟล์คือ 
แบบมีการประเมินค่านิยม 12 ประการ และแบบไม่มีการประเมินค่านิยม 12 ประการ 

 
 
 
5.2. ระดับมัธยมศึกษา มีเฉพาะการประเมินผลสัมฤทธิ์เป็นรายภาคเรียน (ไม่มีรายปี) 
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5.3. ใน 1 ไฟล์กรอกนักเรียนได้ 1 ห้อง ห้องละไม่เกิน 45 คน ถ้ามีหลายห้องเรียนให้คัดลอกไฟล์ตาม
จำนวนห้องเรียน 

5.3.1.กรณีสอนประจำชั้น นักเรียนกลุ่มเดียว ให้กรอกให้ครบทุกวิชาที่สอนใน 1 ไฟล์ 
5.3.2. กรณีสอนประจำวิชา ให้กรอกไฟล์ละห้องเรียน ไฟล์ละวิชาแยกกัน และให้ครูประจำชั้นหรือผู้ที่

ได้รับมอบหมาย ให้ทำไฟล์รวมอีก 1 ไฟล์เพ่ือนำคะแนนรวมและเกรดจากครูประจำวิชาทุกวิชา 
มารวมในไฟล์ใหม่ เพ่ือให้เป็น ปพ.6 และรายงานระดับห้องเรียน (ดูภาพตัวอย่างกระบวนการ) 

 
  เครดิตภาพ : โรงเรียนอนุบาลสังขละบุรี 

5.4. หน้าหลัก/สารบัญ เป็นหน้ารวมเมนูแผ่นงานทั้งหมดในโปรแกรม ซึ่งสามารถ คลิกที่เมนูนั้น ๆ เพื่อให้
เชื่อมโยงไปยังแผ่นงานต่าง ๆ ได้อย่างรวดเร็ว 

5.4.1. องค์ประกอบและการแบ่งหมวดหมู่ 
5.4.2. สามารถคลิกเมนู เพื่อเชื่อมโยงไปยังแผ่นงานต่าง ๆ และคลิกปุ่ม Home สีเขียวเพ่ือกลับหน้า

หลัก 
5.5. คู่มือ 

5.5.1. ควรศึกษาคู่มือก่อนการใช้งาน เพ่ือให้ทราบวิธีการกรอกข้อมูล การแก้ปัญหา และข้อควรระวัง
ในการกรอกข้อมูล 

5.6. ข้อมูลพ้ืนฐาน ได้กำหนดชื่อสถานศึกษาในโปรแกรมเรียบร้อยแล้ว ให้ดำเนินการกรอกข้อมูลพื้นฐาน
อ่ืน ๆ ที่จำเป็นให้ถูกต้อง 

5.6.1. กรอกสังกัดระดับกรม เช่น สำนักงานคณะกรรมการการศึกษาขั้นพ้ืนฐาน หรือ สำนักงาน
บริหารการศึกษาเอกชน  

5.6.2. กรอกตำบล/อำเภอ/จังหวัด 
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5.6.3. กรอกสังกัดระดับเขต เช่น สำนักงานเขตพ้ืนที่การศึกษาประถมศึกษาขอนแก่น เขต 4 
5.6.4. กรอกชื่อ-สกุล ผู้อำนวยการ นายทะเบียน หัวหน้างานวิชาการ และครูประจำชั้น/ประจำวิชา 

5.7. ข้อมูลนักเรียน  
5.7.1. การนำเข้าข้อมูลนักเรียนจากระบบ DMC ของ สพฐ. ชื่อไฟล์ studentInSchoolList.csv  

สามารถคัดลอกข้อมูลนักเรียนจากระบบ DMC มาวางลงในแผ่นงาน “ข้อมูลนักเรียน” ได้ ตาม
ขั้นตอนดังนี้ 

5.7.1.1. การดาวน์โหลดไฟล์ข้อมูลนักเรียนจากระบบ DMC (ดูภาพประกอบ) 
5.7.1.1.1. เข้าระบบ DMC ที่ https://portal.bopp-obec.info/obec65/ 
5.7.1.1.2. กรอกชื่อผู้ใช้งานและรหัสผ่าน คลิกเข้าสู่ระบบ 
5.7.1.1.3. คลิกเมนู โรงเรียน>2.9 รายงานระดับโรงเรียน 
5.7.1.1.4. ที่บรรทัด ทะเบียนนักเรียนรายบุคคล คลิกดาวน์โหลดไฟล์ 

studentInSchoolList.csv หากเป็นข้อมูลภาคเรียนที่ 2 ไฟล์จะอยู่ด้านล่าง 
ให้เลื่อนหน้าเว็บไซต์ลงไปด้านล่างสุดเพื่อดาวน์โหลด 

 
5.7.1.2. เปิดไฟล์ที่ดาวน์โหลดมาและคัดลอกข้อมูลนักเรียนเฉพาะห้องที่ต้องการทำข้อมูล 
5.7.1.3. คลิกท่ีตัวเลขหัวแถว แล้วลากคลุมข้อมูลนักเรียนทั้งแถวลงด้านล่าง 
5.7.1.4. กดปุ่ม Ctrl+C หรือคลิกขวาเลือก คัดลอก (Copy) 
5.7.1.5. คลิกเปิดโปรแกรมงานวิชาการ ที่แผ่นงาน “ข้อมูลนักเรียน”  
5.7.1.6. คลิกขวาที่เซลล์ A3 เลือกเมนูตัวเลือกการวาง “ค่า (า)” ซึ่งเป็นสัญลักษณ์เลข 123 
5.7.1.7. จากนั้น กดปุ่มสีเขียวที่อยู่ด้านขวามือ (ดูภาพประกอบ) หรือกดปุ่ม Ctrl+D เพ่ือ

ปรับปรุงข้อมูล  

https://portal.bopp-obec.info/obec65/
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5.7.2. การกรอกข้อมูลด้วยตนเอง ในกรณีท่ีไม่มีไฟล์ DMC หรือสังกัดอ่ืนนอกจาก สพฐ. สามารถ
กรอกข้อมูลใหม่ด้วยตนเอง (กรุณาอ่านคำแนะนำที่มุมสีแดง) วิธีการกรอกท่ีสำคัญมีดังนี้ 

5.7.2.1. รหัสโรงเรียน จำเป็นต้องกรอก ถ้าไม่กรอกข้อมูลอ่ืน ๆ จะไม่แสดง ถ้าไม่ทราบหรือ
เป็นสถานศึกษาท่ีไม่ได้สังกัด สพฐ. ให้กรอกตัวเลขอะไรก็ได้ 

5.7.2.2. เลขประจำตัวประชาชน ให้กรอกตัวเลขเรียงปกติ ไม่ต้องมีวรรค หรือขีด โปรแกรม
จะประมวลผลให้เองเมื่อกดปุ่มสีเขียว 

5.7.2.3. เพศชายให้กรอก ช เพศหญิงให้กรอก ญ (ตามระบบของ DMC) ถ้ากรอกเป็นอย่าง
อ่ืนนอกจาก ช หรือ ญ โปรแกรมจะประมวลผลเป็นเพศหญิง 

5.8. ข้อมูลเพ่ิมเติม ให้กรอกข้อมูลเพิ่มเติมที่จำเป็น เช่น อาชีพบิดา มารดา และผู้ปกครอง ตรวจสอบและ
แก้ไขท่ีอยู่ปัจจุบันของนักเรียนให้ถูกต้อง 

5.9. กำหนดรายวิชา ให้กรอกข้อมูลชั้นเรียน ภาคเรียน ปีการศึกษา รหัสวิชา รายวิชา เวลาเรยีน (ชั่วโมง/
ปี) กลุ่มสาระการเรียนรู้ และชื่อ-สกุลครูประจำวิชา โดยสามารถกำหนดรายวิชาได้สูงสุด 20 รายวิชา
ต่อปีการศึกษา 

5.9.1. กรณีสอนประจำชั้น นักเรียนกลุ่มเดียว ให้กรอกให้ครบทุกวิชาที่สอนใน 1 ไฟล์ 
5.9.2. กรณีสอนประจำวิชา ให้กรอกไฟล์ละห้องเรียน (นักเรียนกลุ่มเดียว) ถ้าห้องเรียนนี้สอนหลาย

วิชาสามารถกรอกในไฟล์เดียวกันได้ เช่น ห้อง ป.6 สอนวิชาภาษาไทยและสังคมศึกษา สามารถ
ทำเป็นไฟล์เดียวกันได้ แต่ถ้าสอนหลายห้อง (นักเรียนหลายกลุ่ม) ให้แยกไฟล์ละห้องเรียน เช่น 
สอนภาษาไทย ป.4 ป.5 และ ป.6 (นักเรียน 3 กลุ่ม) ให้แยกเป็น 3 ไฟล์เพราะรายชื่อนักเรียน
คนละกลุ่มกัน  

5.9.3. ปกแบบบันทึก ให้ตรวจ แก้ไข และกรอกจำนวนนักเรียน ชาย-หญิง ต้นปีการศึกษา ออก-เข้า
ระหว่างปีการศึกษา และจำนวนรวมให้ถูกต้อง โดยปกจะมีทั้งแบบรายชั้น คือแสดงสรุปผลการ
เรียนทกุวิชา ใช้ในกรณีครูสอนประจำชั้น (คนเดียวสอนทุกวิชา) และแบบรายวิชา คือแสดง
สรุปผลการเรียนแค่วิชาเดียว ใช้ในกรณีครูสอนประจำวิชา 

5.9.4. ชื่อนักเรียน บิดามารดา ผู้ปกครอง จะเป็นข้อมูลที่โปรแกรมประมวลมาจากแผ่นงานข้อมูล
นักเรียนและข้อมูลเพิ่มเติมโดยอัตโนมัติ 

5.9.5. เวลาเรียน มีวิธีการกรอก ดังนี้ 
5.9.5.1.  กรณีสอนประจำชั้น กรอกเป็นจำนวนวันในแต่ละช่อง 

5.9.5.1.1. มาเรียน 1 วัน   ให้กรอกเลข 1 
5.9.5.1.2. ป่วย         ให้กรอก ป 
5.9.5.1.3. ลา           ให้กรอก ล 
5.9.5.1.4. ขาด         ให้กรอก ข 

5.9.5.2.  กรณีสอนประจำวิชา กรอกเป็นจำนวนชั่วโมงในแต่ละช่อง 
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5.9.5.2.1. มาเรียน 1 ชั่วโมง  ให้กรอกเลข 1 
5.9.5.2.2. ป่วย 1 ชั่วโมง      ให้กรอก ป 
5.9.5.2.3. ลา 1 ชั่วโมง       ให้กรอก ล 
5.9.5.2.4. ขาด 1 ชั่วโมง      ให้กรอก ข 
5.9.5.2.5. มาเรียน 2 ชั่วโมง  ให้กรอกเลข 2 
5.9.5.2.6. ป่วย 2 ชั่วโมง      ให้กรอก ปป 
5.9.5.2.7. ลา 2 ชั่วโมง       ให้กรอก ลล 
5.9.5.2.8. ขาด 2 ชั่วโมง      ให้กรอก ขข 

5.9.5.3.  วันหยุดเสาร์-อาทิตย์ และวันหยุดพิเศษ สามารถเว้นว่างไว้ได้ แต่ถ้าต้องการเพ่ิม
หมายเหตุว่าวันใดเป็นวันหยุดพิเศษ สามารถพิมพ์ในพ้ืนที่ตารางด้านล่างใตช้ื่อนักเรียนคน
สุดท้ายได้ 

5.9.5.4.  โปรแกรมจะสรุปเวลาเรียนให้โดยอัตโนมัติในแผ่นงาน “สรุปเวลาเรียน” 
5.10. การบันทึกผลสัมฤทธิ์ทางการเรียน คลิกท่ีแผ่นงานวิชาที่ต้องการบันทึก ซึ่งรายวิชาจะ

เชื่อมโยงมาจากแผ่นงาน “รายวิชา” โดยอัตโนมัติ 
5.10.1. ปุ่มควบคุมด้านขวา 3 ปุ่ม 
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5.10.1.1.  ปุ่มบ้านสีเขียว กดเพ่ือกลับไปที่หน้าหลัก/สารบัญ 
5.10.1.2.  ปุ่มเครื่องหมายบวกสีน้ำเงิน กดเพ่ือเพ่ิมจำนวนคอลัมน์กรอกคะแนน 

(โปรแกรมรายปีเพ่ิมเป็น 48 ช่อง โปแกรมรายเทอมเพ่ิมเป็น 50 ช่อง) และแสดงการ
ประเมินมาตรฐาน/ตัวชี้วัด (ประเมิน 2 ชั้น) 

5.10.1.3.  ปุ่มเครื่องหมายลบสีแดง กดเพ่ือลดจำนวนคอลัมน์กรอกคะแนน (โปรแกรม
รายปีลดเป็น 12 ช่อง โปรแกรมรายเทอมลดเป็นเทอมละ 7 ช่อง 2 เทอมรวม 14 ช่อง) 
และไมแ่สดงการประเมินมาตรฐาน/ตัวชี้วัด (ไมป่ระเมิน 2 ชั้น) 
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5.10.2. กำหนดอัตราส่วนคะแนนระหว่างเรียน : ปลายปี หรือ คะแนนระหว่างภาค : ปลายภาค 
5.10.3. กำหนดหัวข้อการเก็บคะแนน สามารถกำหนดตามบริบทของโรงเรียนได้ เช่น เป็นรายหน่วย 

รายตัวชี้วัด ฯลฯ 
5.10.4. กำหนดคะแนนเต็ม ในแต่ละช่องสามารถเก็บกี่คะแนนก็ได้ โปรแกรมจะคำนวณอัตราส่วนให้

อัตโนมัติ 

 
5.10.5. กรอกคะแนนระหว่างเรียนแต่ละช่อง โดยคะแนนที่ได้ ต้องไม่เกินคะแนนเต็มที่กำหนด 
5.10.6. กรอกคะแนนทดสอบปลายภาค หรือปลายปี 
5.10.7. กรณีชั้น ป.2 ป.4 ป.5 ม.1 และ ม.2 ในรายวิชาที่มีคะแนนข้อสอบกลาง ให้กำหนดร้อยละ

ข้อสอบโรงเรียน ร้อยละข้อสอบกลาง และคะแนนเต็มข้อสอบกลางด้วย 

 
ตัวอย่างการเก็บคะแนนระหว่างเรียน 

โรงเรียนสามารถกำหนดรูปแบบการเก็บคะแนนระหว่างเรียนได้หลากหลายรูปแบบ แล้วแต่โรงเรียน 
เช่น รายหน่วย รายบท รายชิน้งาน รายกิจกรรม รวมทั้งคะแนนสอบระหว่างเรียน สอบกลางภาคได้ด้วย 
หรือหากโรงเรียนต้องการเก็บเป็นรายตัวชี้วัด สามารถคัดลอกรหัสตัวชี้วัดของแต่ละวิชา แต่ละชั้น ในไฟล์ 
Excel ที่แนบมาพร้อมโปรแกรม ไปวางในหัวตารางเก็บคะแนนของแต่ละวิชาได้เลย (ต้องปุ่มเครื่องหมายบวก
สีน้ำเงิน             เพ่ือเพ่ิมจำนวนคอลัมน์กรอกคะแนนก่อน) 
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ตัวอย่างที่ 1 
การกำหนดการเก็บคะแนนระหว่างเรียน เป็นรายตัวชี้วัด ครบทุกตัว สามารถกำหนดคะแนนเต็มของแต่ละตัว
ได้โดยอิสระ เช่น เต็ม 10 ทุกช่อง ในกรณีนี้ ผลรวมของคะแนนเต็มทุกตัว ไม่เท่ากับสัดส่วนคะแนนระหว่าง
เรียน (เช่นรวมกันได้ 220) โปรแกรมจะเทียบสัดส่วนคะแนนให้อัตโนมัติ (เช่นเทียบสัดส่วน 220 เป็น 70) 
คะแนนรวมอาจจะมีทศนิยม 

 
 
ตัวอย่างที่ 2 
การกำหนดการเก็บคะแนนระหว่างเรียน เป็นรายตัวชี้วัด ครบทุกตัว โดยกำหนดคะแนนเต็ม เป็น 4 บ้าง 3 
บ้าง 2 บ้าง 1 บ้าง แล้วแต่จำนวนตัวชี้วัด เพื่อให้ผลรวมของคะแนนเต็มทุกตัว เท่ากับสัดส่วนคะแนนระหว่าง
เรียน (เช่น รวมกันได้ 70) ในกรณีนี้จะไม่มีการเทียบสัดส่วน จึงไม่มีทศนิยม 

 
 
ตัวอย่างที่ 3 
การกำหนดการเก็บคะแนนระหว่างเรียน เป็นรายตัวชี้วัด หลายตัวในช่องเดียว (เช่น รายมาตรฐาน) ทำให้ไม่
ต้องกระจายคะแนนหลายช่อง ผลรวมของคะแนนเต็มทุกตัว เท่ากับสัดส่วนคะแนนระหว่างเรียน (เช่น รวมกัน
ได้ 70) ในกรณีนี้จะไม่มีการเทียบสัดส่วน จึงไม่มีทศนิยม 
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5.11. การประเมินคุณลักษณะอันพึงประสงค์ การอ่าน คิดวิเคราะห์ และเขียนสื่อความ ค่านิยม
หลัก 12 ประการ และสมรรถนะสำคัญของผู้เรียน มีเกณฑ์การประเมินโดยใช้ค่าฐานนิยม (Mode) 
ดังนี้ 

5.11.1. ระดับคะแนน 3   หมายถึง ระดับคุณภาพ ดีเยี่ยม 
5.11.2. ระดับคะแนน 2  หมายถึง ระดับคุณภาพ ดี 
5.11.3. ระดับคะแนน 1   หมายถึง ระดับคุณภาพ ผ่าน 
5.11.4. ระดับคะแนน 0  หมายถึง ระดับคุณภาพ  ไม่ผ่าน 
สำหรับการประเมินคุณลักษณะอันพึงประสงค์ มีช่องเพ่ิมเติมให้อีก 2 ช่อง จากเดิม 8 ช่อง รวมเป็น 
10 ช่อง 

5.12. การประเมินกิจกรรมพัฒนาผู้เรียน กำหนดผลเป็น 2 ระดับ คือ ไม่ผ่าน และ ผ่าน ให้ใส่
เครื่องหมาย / ลงในช่องว่าง 

5.13. เอกสารแนบท้าย ให้ปรินท์เอกสารแนบท้ายเล่ม ปพ.5 สามารถคลิกปุ่มเพ่ือเปิดเอกสารได้แต่
ต้องเก็บไฟล์เอกสารแนบไว้ในโฟลเดอร์เดียวกับโปรแกรม หรือจะคลิกไฟล์เอกสารแนบเพ่ือเปิด
โดยตรงตามปกติก็ได้ เอกสารแนบมีดังต่อไปนี้ 

 
5.13.1. รหัสตัวชี้วัด ของแต่ละวิชา แต่ละชั้น ให้ใช้ตัวชี้วัดในหลักสูตรของโรงเรียน หรือใช้ไฟล์ที่แนบ

มานี้ (แต่ละโรงเรียนอาจจะกำหนดตัวชี้วัดแตกต่างกัน) 
5.13.2. รายละเอียดตัวชี้วัด ของแต่ละวิชา แต่ละชั้น ให้ใช้ตัวชี้วัดในหลักสูตรของโรงเรียน หรือใช้

ไฟล์ที่แนบมานี้ (แต่ละโรงเรียนอาจจะกำหนดตัวชี้วัดแตกต่างกัน) 
5.13.3. คุณลักษณะอันพึงประสงค์ การอ่าน คิดวิเคราะห์ และเขียนสื่อความ 
5.13.4. ค่านิยมหลัก 12 ประการ 
5.13.5. สมรรถนะสำคัญของผู้เรียน 
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5.14. คำชี้แจง ปพ.5 อธิบายการจัดเรียงหน้าเอกสารเมื่อสั่งปรินท์เพ่ือรวมเป็นเล่ม ปพ.5  
ตามแผ่นงาน ดังนี้ 

5.14.1. ปก ปพ.5 (รายชั้น/รายวิชา) 
5.14.2. ชื่อนักเรียน 
5.14.3. บิดา-มารดา 
5.14.4. ผู้ปกครอง 
5.14.5. เวลาเรียน 
5.14.6. ผลสัมฤทธิ์ทางการเรียน (รายวิชาต่าง ๆ) 
5.14.7. คุณลักษณะอันพึงประสงค์/การอ่าน คิดวิเคราะห์ และเขียนสื่อความ 
5.14.8. ค่านิยม 12 ประการ/สมรรถนะสำคัญของผู้เรียน 
5.14.9. กิจกรรมพัฒนาผู้เรียน 
5.14.10. เอกสารแนบท้าย เช่น คำอธิบายรายวิชาและตัวชี้วัด ตัวชี้วดัค่านิยม 12 ประการ 

ฯลฯ 
5.14.11. ปกหลัง 

5.15. ปพ.6 เป็นแบบรายงานประจำตัวนักเรียนเพื่อรายงานผลการพัฒนาคุณภาพผู้เรียนรายบุคคล 
โดยข้อมูลการประเมินต่าง ๆ ใน ปพ.5 ที่ครูประเมินจะสรุปรวมเชื่อมโยงมายังแผ่นงาน ปพ.6 โดย
อัตโนมัติ  

5.15.1. ในกรณีสอนแบบประจำวิชา ครูประจำชั้นหรือผู้ที่ได้รับมอบหมาย ให้ทำไฟล์อีก 1 ไฟล์เพ่ือ
นำคะแนนรวมและเกรด จากครูประจำวิชาทุกวิชา มาหลอมรวมในไฟล์ใหม่ เพ่ือให้เป็น ปพ.6 
และรายงานระดับห้องเรียน เช่น สรุปผลสัมฤทธิ์ ป.6 ปีการศึกษา 2560 เป็นต้น (นำมากรอก
เฉพาะช่องคะแนนรวมเต็ม 100 และผลการเรียน ในกรณีนักเรียน ติด มส ร หรือย้าย ไม่ต้อง
คัดลอกมาท้ังหมด) 

5.15.2. ในกรณีสอนประจำชั้น ใน 1 ไฟล์ต้องกรอกผลสัมฤทธิ์ทุกวิชาอยู่แล้ว  
5.15.3. การจัดเรียงลำดับที่ มีการจัดเรียง 2 แบบคือ ตามคะแนนรวม และตามเกรดเฉลี่ย  
5.15.4. สามารถปรินท์เอกสาร ปพ.6 นี้เพื่อรายงานให้ผู้ปกครองทราบผลการพัฒนาคุณภาพผู้เรียน 

สามารถสั่งปรินท์ทีละคน โดยกรอกเลขที่ แล้วกดปุ่ม Enter เพ่ือให้แสดงข้อมูลของนักเรียน 
หรือคลิกปุ่มสามเหลี่ยมชี้ลง แล้วค้นหาจากรายชื่อของนักเรียนที่ต้องการสั่งปรินท์ คลิก “พิมพ์
ข้อมูลที่แสดง” หรือปรินท์ครั้งเดียวทั้งห้องเรียนได้ เพ่ือความสะดวกในการทำรูปเล่มรายงาน 
โดยกรอก “เริ่มพิมพ์จากเลขที่” “ถึงเลขท่ี” แล้วคลิก “พิมพ์เป็นช่วง”เช่น เลขที่ 1-45 เป็นต้น 

5.16. คะแนนรายชั้น เป็นการสรุปคะแนนผลสัมฤทธิ์ทุกรายวิชาของนักเรียนทุกคนในห้องเรียน 
และการจัดลำดับที่คะแนนรวม 
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5.17. เกรดรายชั้น เป็นการสรุปเกรดทุกรายวิชาของนักเรียนทุกคนในห้องเรียน และการจัดลำดับที่
เกรดเฉลี่ย 

5.18. เกรดร้อยละ เป็นการสรุปผลสัมฤทธิ์ จำนวน และร้อยละของนักเรียนที่ได้ผลการเรียนใน
ระดับต่าง ๆ  

 

6. ข้อควรระวังในการกรอกข้อมูล 
6.1. กรุณาศึกษาคู่มือนี้ให้เข้าใจก่อนเริ่มต้นใช้งาน หากเกิดความเสียหาย อาจไม่สามารถกู้คืนข้อมูลได้ 
6.2. รองรับ Windows Excel2010 ขึ้นไปเท่านั้น เวอร์ชั่นต่ำกว่านั้นไฟล์จะเสียหาย  

(แนะนำ 2016-2019) ไม่รองรับ MacOS 
6.3. ห้ามแทรก/ตัด/ลบ แถว/คอลัมน์/แผ่นงาน โดยเด็ดขาด เพราะจะทำให้การอ้างอิงสูตรไม่ถูกต้อง  

(ข้ึน #Ref) จะไม่สามารถแก้ไขได้ในกรณีนี้ ต้องเริ่มทำไฟล์ใหม่ ให้คัดลอกข้อมูลไปลงในไฟล์
โปรแกรมใหม่ 

6.4. การคัดลอกข้อมูลจากไฟล์งานอื่น ๆ มาลงในโปรแกรม เวลาวางให้คลิกขวา เลือกเมนู "วางค่า" 
เท่านั้น  การวางด้วย Ctrl+V อาจจะทำให้โปรแกรมเสียหาย มีสูตรติดมาด้วย ลิงก์ข้ามไฟล์ 
โปรแกรมล็อค หรือเซลล์ล็อค และปัญหาด้านข้อมูล 

6.5. ในกรณีกรอกข้อมูลผิด ถ้าจะลบข้อมูลให้กดปุ่ม Delete ที่คีย์บอร์ดเท่านั้น ห้ามคลิกขวาแล้ว 
Delete เพราะจะเป็นการลบเซลล์ ทำให้สูตรคลาดเคลื่อนและข้ึน #Ref 

6.6. ในกรณีนักเรียนย้าย หรือลาออก ให้คงชื่อนักเรียนไว้จนสิ้นปีการศึกษา และกรอก “ย้าย” ในทุกช่อง
การประเมินแทน (กรอกในสรุปเวลาเรียน คะแนน เกรด กิจกรรม คุณลักษณะ ฯลฯ) สำหรับระดับ
ปฐมวัย ให้ลง “ย้าย” ในผลการประเมินทั้ง 4 ด้านในเทอม 1 ด้วย (ลงย้ายทั้ง 2 เทอม) เพ่ือให้
จำนวนผลการประเมิน ตรงกับจำนวนนักเรียนสิ้นปีการศึกษา 

6.7. นามสกุลไฟล์คือ .xlsb (Excel Binary Workbook) ห้ามเปลี่ยนนามสกุลไฟล์เพราะจะทำให้
โปรแกรมเสียหาย 

6.8. ควรศึกษาและปฏิบัติตามคู่มือและคำอธิบายการกรอกในส่วนต่าง ๆ ที่ได้จัดทำไว้ 
6.9. หากท่านพบปัญหาในการใช้งาน ต้องการสอบถามข้อมูลเพ่ิมเติมหรือมีข้อเสนอแนะ สามารถติดต่อ

เพจวิชาการได้เสมอครับ www.facebook.com/thaischool 

  

http://www.facebook.com/thaischool
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7. คลิปสาธิตการใช้งาน 
    คลิปสาธิตการใช้งาน : https://www.youtube.com/c/วิชาการ 

    รวมคลิปสาธิตการใช้งานจากโรงเรียนที่ใช้งานจริงครับ อธิบายอย่างละเอียด ทีละขั้นตอน เข้าใจง่าย 
https://thaiexcel.blogspot.com/2019/08/blog-post.html 

 

8. การแก้ปัญหา Excel เบื้องต้น 
8.1. วิธีการเปลี่ยนเลขอารบิกให้เป็นเลขไทย ในแบบ ปพ.2 (ประกาศนียบัตรระดับมัธยมศึกษา) 

8.1.1. คลิกขวาในเซลล์ที่จะแก้ไข 
8.1.2. เลือก จัดรูปแบบเซลล์ 
8.1.3. เลือก กำหนดเอง 
8.1.4. ในช่อง ชนิด ให้พิมพ์ว่า [$-D07041E]0 
8.1.5. กดตกลง 

8.2. ตัวเลขเปลี่ยนรูปแบบไปเม่ือกดปุ่ม Enter เช่นวันที่ วันเกิด เลขประจำตัวประชาชน 3.4105E+12 
8.2.1. ให้ใส่เครื่องหมาย ' ลงไปก่อนตัวเลข (อัญประกาศเดี่ยว) เช่น '31 มีนาคม 2561 

8.3. วิธีแก้วันเกิดแสดงเป็นภาษาอังกฤษ ให้แสดงเป็นภาษาไทย 
สาเหตุ : เกิดจากการตั้งค่าสถานที่และเวลาในระบบคอมพิวเตอร์ไม่ถูกต้อง 
วิธีแก้ไข : ตั้งค่า Format และ Location เป็น Thai (Thailand) ตามข้ันตอนดังนี้ 
7.3.1 คลิกท่ีเวลาและวันที่ตรงมุมจอด้านขวาด้านล่างสุด 
7.3.2 คลิก Change date and time settings... 
7.3.3 คลิก Change date and time... 
7.3.4 คลิก Change calendar settings 
7.3.5 คลิก OK 
7.3.6 แถบ Format เลือก Thai (Thailand) 
7.3.7 แถบ Location เลือก Thailand 
7.3.8 คลิก OK 

8.4. เวลาทำ ปพ.1 คะแนน O-NET ไม่ขึ้น สาเหตุเกิดจาก รูปแบบ เลขบัตรประชาชนนักเรียน ไม่ตรงกับ 
สทศ บางทีในแผ่นงานข้อมูลนักเรียนอาจจัดเก็บเป็นตัวเลขท่ีเป็นข้อความ (เอาไปบวกลบไม่ได้) แต่
ใน สทศ เป็นแบบตัวเลข ดังนั้นต้องตั้งให้ตรงกัน ให้ตรวจสอบและดำเนินการดังนี้ 

8.4.1. ให้มั่นใจว่ากดปุ่มสีเขียวในแผ่นงาน สทศ และแผ่นงาน “ข้อมูลนักเรียน” แล้ว 

https://www.youtube.com/c/วิชาการ
https://thaiexcel.blogspot.com/2019/08/blog-post.html
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8.4.2. ให้ตรวจสอบ เลขประชาชนของนักเรียน ในแผ่นงาน “ข้อมูลนักเรียน” ให้มีรูปแบบตรงกันกับ
ในแผ่นงาน สทศ (เช่น ห้ามมีขีดค่ันหรือเว้นวรรค) 

8.4.3. หากยังไม่ได้ ให้ไปทีแ่ผ่นงาน “ข้อมูลนักเรียน” จากนั้น คลิกขวาที่คอลัมน์ เลขประชาชน
นักเรียน แล้วเลือกจัดรูปแบบเซลล์ เลือกตัวเลข ไม่มีจุดทศนิยม กดตกลง 

8.4.4. หากยังไม่ได้ ให้คลิกท่ีเลขประชาชนนักเรียนคนแรก กดปุ่ม F2 และ Enter สลับกันไปเรื่อย ๆ 
จนถึงนักเรียนคนสุดท้าย เพื่อปรับปรุงรูปแบบเซลล์ 

8.4.5. หากยังไม่ได้อีก ให้ส่งไฟล์มาที ่www.facebook.com/thaischool เพ่ือให้ทีมงานตรวจสอบ
ให้ 
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8.5. การแก้ปัญหาวันเกิดนักเรียนไม่ประมวลผล สาเหตุ เกิดจากการตั้งค่ารูปแบบวันที่ไม่ถูกต้อง 

 
8.5.1. ให้คลิกขวาที่คอลัมน์วันเกิดท้ังหมด เช่น คอลัมน์ M 
8.5.2. เลือกเมนู "จัดรูปแบบเซลล์" 
8.5.3. เลือก "ตัวเลข" 
8.5.4. เลือก "วันที่" 
8.5.5. ชนิดปฏิทิน เลือก "เกรกอเรียน" หรือ "ตะวันตก" 
8.5.6. ชนิด เลือก "14/3/2012" 
8.5.7. ตำแหน่งที่ตั้ง เลือก "ไทย" 
8.5.8. คลิก "ตกลง"   จากนั้นสั่งให้โปรแกรมประมวลผลการกรอกอีกครั้งโดย 
8.5.9. คลิกท่ีช่องวันเกิดนักเรียนที่กรอก 
8.5.10. กดปุ่ม F2 สลับกับปุ่ม Enter ลงไปเรื่อย ๆ จนครบทุกคน 
8.5.11. เช็คผลการแก้ไขว่าเรียบร้อยหรือไม่ 

8.6. เอกสารแสดงไม่ครบหน้า หน้าเอกสารล้นไปหน้าที่ 2 
อาจเกิดจากการตั้งค่าบางอย่าง ขึ้นอยู่กับการตั้งค่าหน้ากระดาษ ปรินเตอร์และคอมพิวเตอร์ ให้ลอง
วิธีต่อไปนี้ 

8.6.1. ตั้งค่าหน้ากระดาษ ลดส่วนหัวกระดาษ ท้ายกระดาษลง 
8.6.2. ลดความสูงของบรรทัดลง 
8.6.3. ทำให้แผ่นงานพอดีกับหนึ่งหน้า ไปที่เมนู ไฟล์>พิมพ์>ไม่มีมาตราส่วน>ทำให้แผ่นงานพอดีกับ

หนึ่งหน้า (แต่ตัวหนังสือจะย่อลง) 
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8.6.4. ตั้งค่าพ้ืนที่พิมพ์ ไปที่เมนู มุมมอง>แสดงตัวอย่างเส้นแบ่งหน้า แล้วลากเส้นประสีน้ำเงิน ไปทับ
เส้นทึบสีน้ำเงิน (แต่ตัวหนังสือจะย่อลง) 

8.7. เวลากดปุ่มสีเขียว โปรแกรมจะแจ้งว่ายังไม่เปิดใช้แมโคร หรือไม่มีแมโครอยู่ในแผ่นงาน 
วิธีเปิดใช้งานแมโครทั้งหมดใน Excel  

8.7.1. ไปที่เมนู แฟ้ม>ตัวเลือก>ศูนย์ความเชื่อถือ>การตั้งค่าศูนย์ความเชื่อถือ>การตั้งค่าแมโคร>เปิด
ใช้งานแมโครทั้งหมด>ตกลง>ตกลง 

8.7.2. เมนูภาษาอังกฤษ : File>Excel Options>Trust Center>Trust Center Settings>Macro 
Settings>Enable all macros>OK>OK 

8.8. วิธีการยกเลิกการซ่อนคอลัมน์ 
8.8.1. เลือกคลุมข้อมูลทั้งหมด โดยนำเมาส์ไปคลิกสี่เหลี่ยมหน้าคอลัมน์ A (อยู่เหนือเลข 1) 
8.8.2. คลิกขวา ที่หัวคอลัมน์ใดก็ได้ เช่น แถว ๆ คอลัมน์ ABC 
8.8.3. เลือก "ยกเลิกการซ่อน" คอลัมน์ที่ถูกซ่อนก็จะแสดงขึ้นมาทั้งหมด 

8.9. คลิกลิงก์ไม่ได้ เกิดจาก Windows ไม่สมบูรณ์  (เกี่ยวกับ Internet Explorer ด้วย) ให้ดาวน์โหลด
และติดตั้งตัวแก้ ลองทำทีละตัว ดังนี้ 

8.9.1. MicrosoftEasyFix50388 จากลิงก์นี้ 
https://1drv.ms/u/s!AuCGLkEAcYapb3c5JZBHO1L-8LM  ดาวน์โหลดและติดตั้ง ถ้ายัง
ไม่ได้ ให้ใช้ไฟล์ที่ 2 

8.9.2. ดาวน์โหลดและติดตั้งไฟล์ Fix_Link_Click.reg จากลิงก์นี้ 
https://1drv.ms/u/s!AuCGLkEAcYapbsw8TYrPOt6AfcE  

8.9.3. สำหรับ Windows 10 ดาวน์โหลดไฟล์และติดตั้งไฟล์ Windows10_Fix_Link_Click.reg จาก
ลิงก์นี้ https://1drv.ms/u/s!AuCGLkEAcYapbUu-_pXbtMRHpbs  

8.9.4. เมื่อติดตั้งเสร็จแล้วให้ Restart คอมพิวเตอร์ 
8.9.5. ถ้ายังไม่ได้ก็ต้องเลื่อนทีละแผ่นงานตามปกติครับ (กดปุ่ม Ctrl + Page Up  หรือ Ctrl + Page 

Down) 
8.10.  ไฟล์ DMC (.csv) เป็นภาษาต่างดาว 

8.10.1. การตั้งค่า Location เป็นภาษาไทย 
https://www.youtube.com/watch?v=Mk_gUIM2UcA 

8.10.2.  ถ้ายังไม่หายให้ตั้งค่าการแปลรหัสภาษา 
https://sysadmin.psu.ac.th/2018/09/17/open-thai-csv-excel-correctly 

8.11. ปัญหา Error 9 เมื่อกดปุ่มรันอัตโนมัติ 
8.11.1. ให้ตั้งค่า System Locale เป็น Thai (Thailand) และติ๊กเครื่องหมายถูกตรง Beta: Use 

Unicode ออก (ไม่ให้มีเครื่องหมายถูก) ตามขั้นตอนดังนี้ 

https://1drv.ms/u/s!AuCGLkEAcYapb3c5JZBHO1L-8LM
https://1drv.ms/u/s!AuCGLkEAcYapbsw8TYrPOt6AfcE
https://1drv.ms/u/s!AuCGLkEAcYapbUu-_pXbtMRHpbs
https://www.youtube.com/watch?v=Mk_gUIM2UcA
https://sysadmin.psu.ac.th/2018/09/17/open-thai-csv-excel-correctly
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กดปุ่ม Start > พิมพ์ค้นหาคำว่า Region Settings เลือก Additional date > Region: 
Change date, time >  Administrative > Change Sytem Locale: Current System 
Locale > Thai (Thailand) > และติ๊กเครื่องหมายถูกตรง Beta: Use Unicode ออก (ไม่ให้มี
เครื่องหมายถูก) > OK 

  
8.12. หากมีปัญหาที่ไม่สามารถแก้ได้ด้วยตนเองหรือต้องการให้ทีมงานช่วยเหลือ 

8.12.1.  สามารถติดต่อได้ที่เฟซบุ๊กเพจวิชาการ www.facebook.com/thaischool 
8.12.2.  สามารถแนบไฟล์โปรแกรมมาให้ทีมงานช่วยแก้ไขให้ได้ทางกล่องข้อความเฟซบุ๊ก 
8.12.3.  ต้องการให้ทีมงานเข้าถึงและการสนับสนุนระยะไกลผ่านทางอินเทอร์เน็ตในคอมพิวเตอร์

ของท่านเลย ให้ติดตั้งโปรแกรม TeamViewer สำหรับการเข้าถึงและการสนับสนุนระยะไกล
ผ่านทางอินเทอร์เน็ต โดยสามารถดาวน์โหลดได้จากลิงคน์ี้ 
https://download.teamviewer.com/download/TeamViewerQS.exe 
เมื่อดาวน์โหลดและติดตั้งโปรแกรมแล้ว ให้แจ้ง Your ID และ Password ที่ปรากฏมาทาง 
เฟซบุ๊กเพจวิชาการ www.facebook.com/thaischool เพ่ือให้ทีมงานออนไลน์และสนับสนุน
ระยะไกลผ่านอินเตอร์เน็ต 
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